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Disclaimer of warranties and limitation of liability 
 
 
Valquest Systems, Inc. provides this manual “as is,” without warranty of any kind either 
expressed or implied.  Valquest Systems, Inc. may make changes and/or 
improvements in this manual at any time and without notice. 
 
Although Valquest Systems, Inc. has gone to great effort to verify the integrity of the 
information herein, this publication could contain technical inaccuracies or typographical 
errors.  Changes are periodically made to the information contained herein.  These 
changes will be incorporated in new editions of this publication.  If further information is 
required contact Valquest System, Inc. support. 
 
There are no warranties, agreements, understandings, expressed or implied, including 
warranties of fitness for a particular purpose or merchantability, other than those 
specifically set out in any existing contract between the parties. Any such contract states 
the entire obligation of Valquest Systems, Inc. The contents of this document shall not 
become part of or modify any contract between the parties.  
 
In no event will Valquest Systems, Inc. be responsible to the purchaser or user in 
contract, in tort (including negligence), strict liability or otherwise for any special, indirect, 
incidental or consequential damage or loss whatsoever, including but not limited to: 
damage or loss of use of equipment, loss of power, additional expenses in the use of 
existing power facilities, plant or power system, cost of capital, or claims against the 
purchaser or user by its customers resulting from the use of the information, 
recommendations and descriptions contained herein. 
 
 
 

Copyright 
 
Copyright© 2015 Valquest Systems, Inc. 
 
All rights reserved.  No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted, in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without prior written permission of the publisher, 
Valquest Systems, Inc. 
 
 
 

Trademarks 
 
All other trademarks are the property of their respective holders. 
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Caution 
 
The information contained in this document covers tasks related to installation, testing 
and operation of specific equipment and is intended for qualified personnel who are 
trained to work with this specific type of equipment.  Personnel performing these tasks 
must understand the hazards of the job.  Information provided in this manual is not a 
substitute for training.  Safety procedures must be followed at all times.  Refer to your 
locally approved safety procedures and safety instructions when working with high 
voltage equipment. 
 
 
 

Safety 
 
This manual and the instructions within are not intended as a substitute for proper 
training.  Only competent technicians who are familiar with this type of equipment should 
install, maintain and operate it. 
 
 
 

Overview 
 
Software Version 
 
Version 7.09.01 is covered in this manual.  Version can be determined by opening the 
VAr-Min Companion Software and selecting Help > About from the top toolbar. 
 
Introduction 
 
This manual provides install instructions, operation procedures and more for the VAr-Min 
Companion Software.  The VAr-Min Companion Software is designed to work with the 
VAr-Min series controllers. 
 
Compatible Part Numbers 
 

 VAr-Min VX1 

 VAr-Min SR2 

 VAr-Min VT2 

 VAr-Min ZV3 

 VAr-Min DT1 
 
 
 

Installation 
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System Requirements 
 
Processor Architecture: 32-bit or 64-bit 
RAM: 1GB 
Hard disk space: 500MB 
Screen Resolution: 1280x1024 minimum 
Operating System: Windows 7, 8.1, 10 
 
Install Software 
 
Installing the VAr-Min Companion Software requires a computer that meets the System 
Requirements0 above and the installation executable. 
 

1. Go to http://valquest.com/Products/VAr-Min_series and select “Latest Software” 
on the right hand side of the screen to download the latest software version 
installer. 

 
 

2. Open the software installer and follow the installer prompts shown below. 
 

http://valquest.com/Products/VAr-Min_series
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Connecting to the VAr-Min 
 

Connecting over USB 
 

The VAr-Min Companion Software allows for easy setup of the VAr-Min over the 
front panel USB port.  The process below details the steps to connect the VAr-Min 
to the VAr-Min Companion Software. 
 
1. Install the VAr-Min Companion Software. See (Installation). 
2. Using the USB cable provided with your VAr-Min, plug one end into your VAr-

Min (while powered) and the other end into your computer. 
a. Windows may attempt the scan for updated drivers.  Allow this to finish. 

3. Open the VAr-Min Companion Software. 
a.  A label should appear at the bottom of the screen, indicating the status 

of the connected device. See (Connection Status page 10) 
4. A window should pop-up automatically showing the device information.  If this 

does not occur, select File > Read from the top toolbar. 
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User Interface 
 
Connection Status 
 
Communication status between the VAr-Min Companion Software and the VAr-Min is 
indicated on the bottom section of the software.  These fields are updated automatically. 
 

 Model:  VAr-Min series 

 Serial Number:  Serial Number assigned at factory 

 Device ID:  ID that was selected by the end user 

 Firmware Version:  Version that is present on the connected VAr-Min  
 
 

 
Figure 1: Connection Status (Example: VAr-Min Connection Good) 

 
Figure 2: Connection Status (Example: VAr-Min Connected but not powered) 

 
Figure 3: Connection Status (Example: No VAr-Min Recognized) 

 
 
 

Program a VAr-Min 
 
Change Single Control Configuration 
 

1. Verify VAr-Min is connected to the VAr-Min Companion Software, indicated in the 
Connection Status section at the bottom of the user interface. 

2. Read current configuration from VAr-Min by selecting (File > Read) from the top 
menu bar. 
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3. You should see a new window pop up with the current information for the 
controller connected. 
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4. Use the Overview, Electrical, Timing, Algorithm and SCADA tabs to modify the 
entries you would like to change.  Once changed, select “Send Parameters.” 
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5. A confirmation pop up box will indicate the success of the transfer.  
 
 
Use Configuration Saved Locally 
 

1. Verify VAr-Min is connected to the VAr-Min Companion Software, indicated in the 
Connection Status section at the bottom of the user interface. 

2. Open the saved configuration you would like to program into the VAr-Min by 
selecting (File > Open). 
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3. Select the configuration you would like to program into the VAr-Min from the list. 
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4. Select “Send Parameters.” 
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5. A confirmation pop up box will indicate the success of the transfer.  
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VAr-Min Configuration 
 
The VAr-Min is programmed with a configuration that tells it the parameters of the 
system it will be installed in.  This configuration can be viewed and changed through the 
VAr-Min Companion Software.  The below sections cover the parameters that can be set 
in the control.  Dependent upon the model being configured, some of these features may 
or may not be available.  The program will indicate available features based on model. 
 
Overview 
 
The Overview screen provides an overview of the configuration for the VAr-Min.  This 
includes parameters set in Electrical, Timing, Algorithm, Rack Components, and 
Database tabs.  This is also where a Passcode and Unit ID can be viewed and set. 
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Figure 4: Configuration Overview 

 
Electrical 
 
The Electrical screen allows programming of electrical parameters and components 
located on the capacitor rack.  These values affect both calculations and automatic 
control.  After setting the desired parameters, the Send Parameters button may be used 
to write the new settings to the connected VAr-Min.   
It would be helpful to have a thorough understanding of the information contained in 
sections 4, 5, 6 and 8 of the VAr-Min Control Manual. 
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Figure 5: Configuration Electrical 

 
Electrical (Voltage Constants) 
 
The Voltage Constants division describes the nominal line voltage conditions for 
the capacitor control.  Proper voltage constants are important for electrical 
parameter calculations and switching decisions. 

 Primary Voltage – has the most common distribution line voltages in the 
pull-down menu.  However, any reasonable phase to neutral voltage can 
be entered. As the phase to neutral voltage is changed the phase to phase 
value will change as a convenient reference. 

 Secondary Voltage – has only two options: 120 and 240 VAC. 

 Line Frequency – has only two options: 60 and 50 Hz. 
 

Electrical (Current Sensing) 
 
The Current Sensing division describes the current measuring equipment that will 
be used by the capacitor control.  As with the voltage constants, these values are 
necessary for electrical parameter calculations and switching decisions.   
Current accuracy is between 1% and 2% of full scale.  It is normal to read some 
noise when current level is below 2%. 

 Line Post Current Sensor – When this option is selected the following 
entries are presented: 

o Line Post Sensor Type – is a pull-down menu of several standard 
LPCSs.  They include: 
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 Generic 
 Lindsey Multi-Core 
 Fisher-Pierce 1301 x7A 
 Fisher-Pierce 1301 x1A 

o Max Expected Line Current – sets the front end gain on the current 
input amplifier.  This is to avoid clipping of the current waveform.  
Higher values allow for more current but have less resolution.  

o Current Sensor Ratio – the current to voltage ratio of the LPCS.  It is 
automatically populated with the ratio of the selected line post 
sensor and is only available for change by the user when the 
Generic type of sensor has been selected. 

o Characteristic Phase Shift – the inherent phase shift of the LPCS.  It 
is automatically populated with the ratio of the selected line post 
sensor and is only available for change by the user when the 
Generic type of sensor has been selected. 

 CT – When the CT option is selected the following entries are presented: 
o CT Ratio – the CT current ratio and can be expressed as xxx:5 or 

xxx:1 
o Max Expected Line Current – for reference only and allows the user 

to see where current waveform may be clipped. 
o Phase difference – normally zero however, it can be adjusted when 

the CT is not on the same phase with the voltage transformer.  An 
engineering calculation based on the particular configuration will 
need to be made to determine the proper value for this.  

 
Electrical (Switching Delta V) 
 
The Switching Delta Voltage section allows the user to monitor and change the 
learned delta voltage values.   

 The Close value represents the average secondary voltage increase that 
occurs when the capacitor bank is energized.   

 The Open value represents the average secondary voltage decrease that 
occurs when the capacitor bank is de-energized. 

 The Send deltaVs checkbox allows the user not to send the shown values 
when sending other updated electrical parameters.  The default is not 
checked because these are learned values and are always being updated 
by the VAr-Min. 

 The Learn Mode checkbox allows enabling or disabling Delta V learning. 
More information is available in the VAr-Min Operator Manual section 8.4. 

 
Electrical (Current Phasing) 

  
The Current Phasing section is convenient for adjusting the polarity of the current 
sensor relative to the voltage sensor. 

 Auto-Correct – will automatically adjust the current signal polarity such that 
the calculated kW is always positive. 
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 Standard – used when the current sensor is installed with polarity correctly 
phased with the voltage sensor and power direction is a necessary 
measurement.  An example of this necessity might be when the possibility 
of a back feed condition exists. 

 Reversed – used when the current sensor is installed with polarity opposite 
to that of the voltage sensor and power direction is a necessary 
measurement. 

More information is available in the VAr-Min Operator Manual section 8.5.4. 
 

Rack Components (Switch Status Sensing) 
  

The Switch Status Sensing section allows selection of the method the VAr-Min will 
use to determine switch position.  Options include: 

 No Sensing – Position is determined strictly by assuming the switches are 
in the state last commanded by the control. 

 Open Control Wire – Position is determined by observing impedance to 
neutral of the Open control wire. 

 Close Control Wire – Position is determined by observing impedance to 
neutral of the Close control wire. 

 Both Wires – Position is determined by observing impedance to neutral of 
both the Open and Close control wires.  This option allows discovery of 
situations where the switches are not all in the same state or the control 
cable has a broken wire or wires. 

More information is available in the VAr-Min Operator Manual section 8.5.10. 
 

Rack Components (Tripping) 
  

The Tripping section allows selection of either AC or DC tripping.   

 AC tripping is required when using motor operated switches. 

 DC tripping is only possible with solenoid operated switches and is required 
for fast relaying. 

More information is available in the VAr-Min Operator Manual sections 2.6, 8.3 
and 8.5.12. 

 
Rack Components (Transformer Primary) 

  
The Transformer Primary section is where the user will select whether the bank 
transformer primary is connected Phase – Neutral or Phase – Phase.  Proper 
selection of the transformer primary connection is necessary for accurate 
electrical parameter calculations. 
More information is available in the VAr-Min Operator Manual section 8.5.1. 

 
Rack Components (Cap Bank Fuse Loss Sensing) 
 
The Cap Bank Fuse Loss Sensing section is used when blown fuse detection is to 
be done.  Fuse loss sensing is accomplished with a bank neutral CT in the case of 
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a grounded wye or a center to neutral PT in the case of an ungrounded wye.  
Options for this section are: 

 CT – placed in the bank neutral conductor for a grounded wye 
configuration 

o CT Ratio – sets the CT current ratio 
o Threshold – sets the current level for determining a blown fuse 

 PT – primary placed between the bank center and neutral for an 
ungrounded wye 

o PT secondary – sets the PT secondary nominal voltage 
o Threshold – sets the voltage for determining a blown fuse 

 None – when selected, indicates that no blown fuse detection is to be 
done. 

More information is available in the VAr-Min Operator Manual sections 8.5.8, 8.5.9 
and 8.6.11. 

 
 
Timing 
 
The Timing screen allows programming id time and date parameters mostly used in the 
control scheme for the VAr-Min.  These values affect both automatic control and 
protective control.  After setting the desired parameters, the Send Parameters button 
may be used to write the new settings to the connected VAr-Min.   
It would be helpful to have a thorough understanding of the information contained in the 
VAr-Min Control Manual sections 6 and 8. 
 

 
Figure 6: Configuration Timing 
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Timing Parameters (Transient Condition Delays) 

  
The Transient Condition Delays section is for programming timings associated 
with normal conditions capacitor control.  Normal conditions are conditions that 
occur periodically with load changes as opposed to abnormal conditions such as a 
power outage, a blink or a self-exciting condition that result in activation of Fast 
Tripping.  
When these values are entered in the VAr-Min Companion Software, the Close 
and Open values can be different.  The VAr-Min front panel wizard automatically 
assigns the entered value to both the Close and Open parameters. 

 Close after and Open after – these entries are the Transient Delays 

 minus – these entries are the Delta Voltage Multipliers  
More information is available in the VAr-Min Operator Manual sections 8.6.9 and 
8.6.10. 

 
Timing Parameters (Fast Trip Relay) 

  
The Fast Trip Relay section is for programming the Fast Voltage and Frequency 
Relay timings. These timings are much faster than the Transient Delays – from 
0.1 to 5.0 seconds. 

 Voltage – sets the Voltage Relaying Delay 

 Frequency – sets the Frequency Relaying Delay 
More information is available in the VAr-Min Operator Manual sections 2.6, 8.3 
and 8.5.12 

 
Timing Parameters (Switch Type (Energize Duration)) 

  
The Switch Type (Energize Duration) section allows for different types of switch 
control timings.  It is self-explanatory. 

 
Timing Parameters (Capacitor Discharge Inhibit) 

 
The Capacitor Discharge Inhibit section selects the American (ANSI/IEEE) or 
European (IEC) standard for capacitor discharge time before allowing 
energization of the capacitor bank after it has been de-energized.  

 
Timing Parameters (Anti-Oscillation Inhibit) 

  
The Anti-Oscillation Inhibit is a protection scheme against the possibility of an 
inadvertent control algorithm that continuously cycles the bank on and off. It 
imposes limits on two things:  

1. How often the bank switches can change states (normally – not including 
fast tripping) 

2. How many times the switches can change states continuously with little or 
no delay before the control will be taken out of automatic mode. 

The programmable parameters that control this are: 
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 Anti-Oscillation Inhibit Active check box – enables Anti-Oscillation Inhibit 
when checked. 

 Between Operations entry – sets the minimum time between normal 
operations. 

 Consecutive Ops entry – sets the number of consecutive operations before 
entering Remote (non-automatic) mode. 

 
Timing Parameters (Remote Mode – 1 Hour Timeout) 
 
The Return to Auto check box in the Remote Mode section, if checked, tells the 
VAr-Min to return to Automatic mode one hour after it was set to Remote mode by 
the SCADA system.  This is to avoid inadvertently leaving the control in a non-
automatic operating condition indefinitely. 

 
Timing Parameters (Inside Temperature Calculation) 

 
The Temperature Lag entry in the Inside Temperature Calculation section sets a 
time constant for simulation of in-door temperatures using the outside measured 
temperature.  This facilitates estimation of load conditions when using 
temperature as part of the control algorithm. 

 
Holidays (Date List (mm-dd-yy)) 

  
The Holidays Date List allows up to fifty holidays to be programmed into the VAr-
Min for use with the control algorithm, when using Day of the Week as one of the 
control criteria.  For each entry, Month, Day, Year and a day of week replacement 
are entered. When the VAr-Min determines that the current date matches one of 
the entries the entered DOW will be substituted for the actual day of the week for 
control purposes.   
Any number from 0 to 9 can be entered in the DOW.  The normal days of the 
week are consecutive with 1 for Monday and 7 for Sunday.  0, 8, and 9 as well as 
1-7 can be entered into the Holiday Date List as DOW and the algorithm can treat 
them differently if so programmed. 

 
Algorithm 
 
The Algorithm screen allows programming of the control algorithm either directly or using 
the Algorithm Wizard.  After building the desired algorithm, the Send Parameters button 
may be used to write the new settings to the connected VAr-Min 
A thorough understanding of the information contained in the VAr-Min Control Manual 
section 8 and 8.4 in particular will be essential to understand the following discussions. 
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Figure 7: Configuration Algorithm 

 
Algorithm (With Switches Open) 

 
These are the Open Steps as described in the VAr-Min Operation Manual section 
8.4.  The interface allows steps to be added, deleted, inserted or edited.  To 
Delete, Insert above or Edit the step must first be clicked.  This will turn it red and 
enable the buttons.  
Here is a description of each of the buttons located in the panel: 

 Add Step – Opens the edit screen (see below) with an indication that the 
Open Step below the last existing Open Step is being edited. 

 Edit – Opens the edit screen with an indication that the Open Step 
previously clicked on (and currently red) is being edited. 

 Insert – Shifts Open steps down one step starting with the Open Step 
previously clicked on and opens the edit screen with an indication that the 
Open Step previously clicked on (and currently red) is being edited. 

 Delete – Shifts Open Steps up one step starting with the Open Step 
previously clicked on, effectively deleting it. 

 Cancel – Turns whatever step was previously clicked on from red back to 
black and greys out the edit buttons. 

 
Algorithm (With Switches Closed) 

  
These are the Closed Steps as described in the VAr-Min Operation Manual 
section 8.4.  The interface allows steps to be added, deleted, inserted or edited.  
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To Delete, Insert above or Edit the step must first be clicked.  This will turn it red 
and enable the buttons.  
Here is a description of each of the buttons located in the panel: 

 Add Step – Opens the edit screen (see below) with an indication that the 
Closed Step below the last existing Closed Step is being edited. 

 Edit – Opens the edit screen with an indication that the Closed Step 
previously clicked on (and currently red) is being edited. 

 Insert – Shifts Closed steps down one step starting with the Closed Step 
previously clicked on and opens the edit screen with an indication that the 
Closed Step previously clicked on (and currently red) is being edited. 

 Delete – Shifts Closed Steps up one step starting with the Closed Step 
previously clicked on, effectively deleting it. 

 Cancel – Turns whatever step was previously clicked on from red back to 
black and greys out the edit buttons. 

 
Edit Open of Closed Step #X 

 
This panel is displayed when a step edit is in progress.  It is displayed as a result 
of any of the Add, Edit, or Insert buttons being clicked.  The Edit panel has five 
sections which correspond to the five elements of the algorithm steps: 

 Parameter – sets the parameter in the Parm column of the Steps table. 

 Is – sets the operator in the evaluate column. 

 Value – sets the value in the Val column. 

 If True – sets the directive in the T column. 

 If False – sets the directive in the F column. 
Directives have the following meanings: 

 Stay Open O  used in Open steps to keep status quo  

 Close  C used in Open steps to close the switches 

 Stay Closed C used in Closed steps to keep status quo 

 Open  O used in Closed steps to open the switches 

 Next  N used in any steps to move evaluation to next step 

 Skip  S used in any steps to move evaluation two steps 

 Trip  T used only in Closed steps for relay tripping of the 
switches 

Buttons OK and Cancel will save the edited step or cancel the edit. 
 

Wizard Panel 
 

The Wizard panel enables the user to view and duplicate a Wizard algorithm built 
through the VAr-Min front panel.  Each parameter is a duplicate of those available 
when operating a VAr-Min directly. 
Please refer to the VAr-Min Operator Manual section 8.6 for a description of each 
of the parameters seen in the Wizard panel. 
To build an algorithm from this panel, the desired selections should be made from 
each section and then the Build Algorithm button will be clicked.  This will build the 
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proper steps into the Algorithm panel on the left.  The algorithm is then ready to 
write to the VAr-Min using the Send Parameters button. 

 
SCADA 
 
The SCADA screen facilitates programming the VAr-Min for SCADA use.  The VAr-Min 
supports two protocols through its communications ports: 

 Modbus RTU  Port 0 

 DNP 3.0  Port 1 
After setting the desired parameters, the Send Parameters button may be used to write 
the new settings to the connected VAr-Min.  The Save DNP Template and Load DNP 
Template buttons are used to save and retrieve the DNP settings for use in other VAr-
Mins. 
 

 
Figure 8: Configuration SCADA 

 
Modbus Communication 

 
This section allows entry of: 

 Address  1 – 253 

 Baud Rate  1200 – 115200  
 

DNP Communication 
 

This section allows entry of: 
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 Address  1 – 65533  

 Baud Rate  1200 – 115200 

 SCADA Master Clk VAr-Min uses the internal clock set periodically by 
SCADA     rather than its own RTC 

 Unsolicited Resp VAr-Min issues unsolicited report by exception 
responses 

 Unsolicited Addr Unsolicited response destination address 

 Notify Delay Sec Time till reporting change events if fewer than Min 
Events 

 Min Events  Minimum number of events to report before Notify 
Delay  

 Retry Delay Sec Time to wait to retry URBE if no confirm from master 

 BI Class  Binary Input RBE Class (0 means none) 

 AI Class  Analog Input RBE Class (0 means none) 
 

DNP Deadbands 
  

This section allows entry of Analog Input report by exception Deadbands.  Entries 
are in floating point format so they can use decimal places.  For example: 
Secondary Voltage entered as 0.5 would give a one half volt deadband.   An entry 
of zero (0) disables the RBE function for that Analog Input parameter. 

 
DNP Analog Map 

  
This section allows user customization of the Analog Inputs.  Only the parameters 
listed in the Not Mapped panel of the DNP Analog Input Map will be available 
through DNP and in that order. 
To customize the map use the right and left arrows to move marked items 
between the two panels.  Use the up and down arrows to arrange the items in the 
Mapped panel in the desired order.  The two digit number at the left of each 
parameter will be its DNP Analog Input index.  

 
DNP Binary Map 
 
This section allows user customization of the Binary Inputs.  Only the parameters 
listed in the Not Mapped panel of the DNP Binary Input Map will be available 
through DNP and in that order. 
To customize the map use the right and left arrows to move marked items 
between the two panels.  Use the up and down arrows to arrange the items in the 
Mapped panel in the desired order.  The two digit number at the left of each 
parameter will be its DNP Binary Input index. 

 
 
 

Instantaneous 
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Displays the Instantaneous readings of either the currently connected VAr-Min or the 
simulator if open. 
 
Setting Date and Time 
 
Date and Time can be set using the Instantaneous window to the current computers 
time. 
 

1. Verify VAr-Min is connect to the VAr-Min Companion Software indicated in the 
Connection Status section at the bottom of the user interface. 

2. Select “Instantaneous” from the main toolbar. 

 
 

3. Select “Set Time” once.  The text will turn red and indicate it is ready to set the 
time and date.  Select “Set Time” again and now the date and time on the VAr-Min 
is set to the current computer time. 
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Calibrating Voltage and Current 
 
Calibration is performed at the factory but can be performed again to calibrate the 
Voltage and Current inputs to the VAr-Min Control. 
 

4. Verify VAr-Min is connected to the VAr-Min Companion Software, indicated in the 
Connection Status section at the bottom of the user interface. 

5. Select “Instantaneous” from the main toolbar. 
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6. Select “Calibration.” 
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7. Follow the Procedure in the Calibration section to perform a calibration.  
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Historical 
 
Historical data can be downloaded from the VAr-Min and viewed or exported from the 
VAr-Min Companion Software. 
 
Operations Log 
 
Tracks the operations of the capacitor switches attached to the VAr-Min.  Based on 
switch position sensing settings, this can track more than just the output of the VAr-Min. 
 
Trending Records 
 
Trending information can be downloaded from the VAr-Min and displayed graphically or 
exported.  These records provide 15-minute interval data.  Parameters recorded are: 

 Voltage (Secondary Voltage) 

 kV (Primary Voltage) 

  Current 
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 kW 

 kVAr 

 kVA 

 Power Factor 

 Lead/Lag state 

 Temperature 

 Status (capacitor switch status) 
 
 
 

Simulator 
 
The VAr-Min Simulator simulates a VAr-Min Capacitor Control, three capacitor switches, 
a capacitor bank, and line conditions.  This allows you to become familiar with the user 
interface of the VAr-Min Capacitor Control and simulate different line conditions.  A user 
can simulate different line characteristics by changing the Voltage, Current, kW, kVAr, 
PF, dV, Temp, Bank kVAr, Switch Failure and more.  Operators can be trained safely 
without having to interact with energized hardware. 
 
Open the simulator by selecting “Simulator” on the main toolbar. 
 

 
Figure 9: Simulator 
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Manual Changelog 
 
V1.0 

 Initial release 
V1.1 

 Revised formatting 

 Added references to VAr-Min Manual 
V1.2 

 Added diagrams 

 Revised DNP section 
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